Creating HTML Help with Microsoft's HHW

by Ceriel B. Cunanan, ECE
## Contents

### What Is HTML Help?
- What Are the Advantages of HTML Help? ................................................................. 2
- Are There Any "Gotchas"? ......................................................................................... 2
- Comparing HTML Help to WinHelp........................................................................ 3
- Comparing HTML Help to HTML-Based Help ......................................................... 4

### Understanding HTML Help Workshop (HHW)
- Using the Interface ................................................................................................... 5
  - Menu Options ........................................................................................................ 5
  - Tabs ....................................................................................................................... 6
  - Toolbars................................................................................................................ 6
- What Are the Advantages of HHW? ......................................................................... 9
- What Are the Disadvantages of HHW? ................................................................... 9
- Converting WinHelp Projects with HHW .............................................................. 9
  - Advantages ........................................................................................................ 9
  - Disadvantages .................................................................................................... 10

### Creating an HTML Help Project with HHW
- Creating a Project File ............................................................................................ 11
- Modifying the Project Settings ............................................................................... 13
- Customizing the Window ....................................................................................... 15
- Adding a Search Stop List ..................................................................................... 18
- Exercise 1: Creating a Project ............................................................................... 18

### Working with Topics
- Creating New Topics .............................................................................................. 19
- Adding Topics to a Project .................................................................................... 20
- Applying Style Sheets to Topics .......................................................................... 21
- Setting the Default Topic ..................................................................................... 21
- Exercise 2: Adding Topic Files .............................................................................. 22

### Saving and Compiling
- Setting the Compilation Options .......................................................................... 24
- Compiling the Project ........................................................................................... 25
- Viewing the Results .............................................................................................. 26
- Exercise 3: Compiling the Project ......................................................................... 26
Creating Hyperlinks

Creating Text-Only Popups..............................................................................................................28
Creating the Script..........................................................................................................................28
Creating the ActiveX Control ........................................................................................................29
Creating the Hyperlink ..................................................................................................................29
Exercise 4: Creating Hyperlinks ...................................................................................................29

Designing the Table of Contents

Creating the Table of Contents......................................................................................................31
Changing the Contents Settings .....................................................................................................32
Changing the Headings and Pages Settings..................................................................................33
  Adding Headings .......................................................................................................................34
  Adding Pages ...........................................................................................................................34
  Assigning Topics to Headings ....................................................................................................35
Modifying Your Project to Use the Contents File ...........................................................................35
Exercise 5: Creating a Table of Contents .......................................................................................35

Designing an Index

Understanding the Differences: Sitemap and Binary Indexes .........................................................37
Creating an Index ............................................................................................................................38
Adding Index Entries to the Index File ............................................................................................39
Adding Keywords to Topic Files ...................................................................................................40
Creating See and See Also Keywords ............................................................................................41
Sorting the Index ............................................................................................................................42
Changing the Index Settings .........................................................................................................42
Modifying Your Project to Use the Index File ................................................................................43
Exercise 6: Creating an Index ........................................................................................................43

Adding Graphics to the Project

What Graphic Formats Can Be Included? .......................................................................................45
Inserting Graphics ..........................................................................................................................46
Exercise 7: Inserting Graphics .......................................................................................................46

Adding the HTML Help Control

Designing HTML Help Control Links and Results .........................................................................49
  Designing the Links ...................................................................................................................50
  Designing the Results ................................................................................................................50

Designing "No-Hit" Links

Creating a Related Topics Button ..................................................................................................51
Creating a Keyword Search Button...............................................................................................55
Exercise 8: Creating HTML Help Controls ..................................................................................56

Distributing Your Help File

Preparing for Distribution ..............................................................................................................57
CHAPTER 1

What Is HTML Help?

- HTML Help is the current Windows Help standard, combining the functionality of WinHelp with the flexibility of Hypertext Markup Language (HTML) and the power of ActiveX controls and scripts.
  - *HTML* is a browser-independent tagging language used to display information on the World Wide Web. It enables you to display text and graphics and use hyperlinks to navigate to other HTML documents.
  - HTML doesn't include WinHelp functionality, such as pop-ups, Tables of Contents, Indexes, full text search, and Related Topics.
  - HTML Help has a slightly different look than WinHelp. Instead of one screen for the navigation tabs (Table of Contents, Index, and Full-text Search) and another screen for the content, HTML Help combines both into one screen, along with a third component, the toolbar. This gives the main window its name (tri-pane).
  - This interface enables users to see where they are within the navigational structure.
What Are the Advantages of HTML Help?

- Help files created with HTML Help are much smaller than their counterparts created in WinHelp and there are virtually no limits (file sizes, number of files, and so on).
- You have full control over both tables and text. Unlike WinHelp, which doesn't allow for any kind of table formatting and little text formatting, HTML allows both.
- You don't lose much WinHelp functionality. You can still provide popups (albeit text-only, with no formatting), Tables of Contents, Indexes, full-text search, and Related Topics. Some third-party Help Authoring Tools provide for fully-formatted text popups.
- Improvements made to HTML can be immediately implemented in HTML Help. For example, HTML was at version 2 when HTML Help was announced. Now, HTML is at version 4, enabling us to take advantage of Cascading Style Sheets, JavaScript, and so on.
- Using scripts, HTML Help Objects, and ActiveX components, developers can deliver as much or as little functionality as they choose.
- HTML Help offers better navigational aids. When developing an HTML Help file, you can specify that the Table of Contents should synchronize with the content displayed on the right when the Contents tab is displayed on the left. This means that users can always track their progress within the topics of the HTML Help file. You can add full-text search (basic and advanced) and a Favorites tab that enables users to bookmark frequently used topics.
  - When an HTML Help file is synchronized, users can display information using any means (the Index, through Full-text Search, or the Favorites tab), and then select the Table of Contents to see where the topic falls within the hierarchy. However, the topic must exist in the Table of Contents for synchronization to work.
- You can provide context-sensitive Help for applications. Your developers need to use a form of the HTML Help API, which can be found in the HTML Help Workshop Help file.
- The implementation of context-sensitive Help changes for different development environments. API calls can be encapsulated in a DLL, such as David Liske's HTML Help Object Library DLL. If this is used with any COM-enabled programming environment (such as Microsoft Visual C++, Borland Delphi, Sybase PowerBuilder, etc.), your developer doesn't need to worry about the API and can use the properties and methods of the DLL instead. If your developer is using Microsoft Visual Basic 5 or 6, Liske's HTML Help Class Module provides the same interface as the HTML Help Object Library DLL, but with better performance.

Are There Any "Gotchas"?

- One major requirement for HTML Help is that Internet Explorer (version 4 or later) MUST be installed on the user's system. It must also be installed on your system. HTML Help files use runtime components from IE to display their content. However, neither you nor your users actually have to use IE when surfing the Web.
- Also, HTML Help doesn't use any of the 88+ WinHelp macros. If you've developed WinHelp files, you might have used these macros for increased functionality. Although some macros have corresponding ActiveX controls (for example, Related Topics), most do not. You might have to write your own scripts, or have a developer write a DLL or ActiveX control, if there's something special you want to provide for your users.
Comparing HTML Help to WinHelp

Similarities

• Compiled results (.hlp for WinHelp and .chm for HTML Help)
• Multiple windows (main, secondary, and popups)
• Table of Contents and Index
• Full-text search
• Static graphics (although each type uses different formats)
• Hotspot graphics and multimedia
• Hyperlinks
• Formatting topics (font families, colors, and sizes)
• Context-sensitive Help
• Browse sequences (although HTML Help requires more work)
• Related Topics, Keyword Links, and A-Keyword Links

Differences

• Fully functional tables in HTML Help
• Fully functional fonts (superscript, subscript, and so on) in HTML Help
• Non-scrolling regions in WinHelp (can be scripted in HTML Help)
• Macros in WinHelp
• Scripting in HTML Help
• Formatted popups in WinHelp, vs. text-only popups in HTML Help
Comparing HTML Help to HTML-Based Help

**Similarities**
- Cascading Style Sheets
- Expanding/collapsing Table of Contents
- Multi-level Index
- Hyperlinks to URLs, email addresses, newsgroups, or FTP sites
- Popups
- Related Topics lists
- Scripts (JavaScript for both; VBScript for Internet Explorer only)
- Images and Image Maps
- Multimedia
- Forms
- Context-sensitive Help

**Differences**

<table>
<thead>
<tr>
<th>Option</th>
<th>HTML Help</th>
<th>HTML-based Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating systems</td>
<td>Windows 32-bit only (95/98/NT)</td>
<td>Any</td>
</tr>
<tr>
<td>Compilation</td>
<td>Compiled</td>
<td>Not compiled</td>
</tr>
<tr>
<td>Browsers</td>
<td>None (but IE4 or above must be installed)</td>
<td>All</td>
</tr>
<tr>
<td>Deploying files</td>
<td>Deploy one file</td>
<td>Deploy all files</td>
</tr>
<tr>
<td>Internet access</td>
<td>Runs locally</td>
<td>Runs over the Internet</td>
</tr>
<tr>
<td>Full-text search</td>
<td>Yes</td>
<td>Depends on tool</td>
</tr>
<tr>
<td>Default display format</td>
<td>Yes</td>
<td>Browser-dependent</td>
</tr>
<tr>
<td>Auto-synchronization in the Table of Contents</td>
<td>Yes</td>
<td>Depends on tool</td>
</tr>
<tr>
<td>Cross-file linking</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Merging</td>
<td>Yes</td>
<td>Depends on tool</td>
</tr>
</tbody>
</table>
Chapter 2

Understanding HTML Help Workshop (HHW)

- Microsoft provides HTML Help Workshop (HHW) free from their Web site.

- However, HHW includes only a text-based HTML editor, requiring you to know HTML when making changes.
  - You can use any HTML Editor to create your HTML files.
  - These HTML files, commonly called “topics,” display Help information.

- HHW includes full HTML Help functionality, including Table of Contents and Index designers, HTML Help objects through hhctrl.ocx, context-sensitivity, and an HTML Help Image Editor.

- There are numerous HTML Help authoring tools on the market that make development much easier. See the HAT Comparison Matrix (http://www.helpstuff.com/downloads/toolsv5.pdf) (PDF, Version 5). You can enhance your Help file with KeyTools, provided by KeyWorks (http://www.keyworks.net) and WorkWrite (http://www.workwrite.com).

Using the Interface

HHW includes menus and toolbars. The available options that display depend on whether an HTML file is open in the editor. It also includes three tabs in the left pane.

Menu Options

- HHW (when an HTML file isn't open) includes the following menu options:
  - **File**
    - New, Open, Close Project, Close All, Save Project, Compile, Decompile, CHM Information, Preferences
  - **View**
    - Toolbar, Status Bar, Compiled Help File, HTML Help Messages
  - **Test**
    - Pop-up Attributes, Keyword Lookup, HtmlHelp API
  - **Tools**
    - HTML Help Image Editor
• **Help**
  Help Topics, HTML Tag Reference, Version

• When an HTML file is open, the following menu options are added:

  • **File**
    Close File, Save All Files, Save File, Save File As

  • **View**
    Set Font, In Browser

  • **Window**
    Cascade, Tile Horizontally, Tile Vertically, Arrange Minimized Windows

  • **Edit**
    Undo, Cut, Copy, Paste, Select All, Compiler Information, Split File, Find, Find Next, Replace

  • **Tags**
    Insert Text Block, Edit Text Block, Character Formatting, HTML Help Control, Heading, Comment, Title

**Tabs**

• Once you open a project, three tabs display on the left side of HHW. These tabs contain the Project, Contents, and Index information.

**Toolbars**

• The main toolbar appears when you first open HHW and remains when you open projects or HTML files.

  • **New**
    Displays the New dialog box, where you can select to create projects, HTML and text files, table of contents, and index.

  • **Open**
    Displays the Open dialog box, where you open a project or HTML files. Type an extension in the File name input box to open a specific file (such as .hhk for Index or .hhc for Contents).

  • **Compile HTML File**
    Compiles your project.

  • **View Compiled File**
    Displays the results.

  • **Display Online Information**
    Displays the appropriate HTML Help topic in an embedded Help window within HHW.
Once you open a project, the Project toolbar appears at the left.

- **Change Project Options**
  Displays a tabbed dialog box with the General, Files, Compiler, and Merge Files setting.

- **Add/Remove Topic Files**
  Displays the Topic Files dialog box.

- **Add/Modify Window Definitions**
  Displays the Add Window dialog box if no windows have been created. Once you've created one or more windows, the Window Types dialog box displays, where you can modify the window settings.

- **HtmlHelp API Information**
  Displays the Map, Alias, and Text Pop-ups tabs, where you can add and remove context-sensitive Help information.
  
  While later versions of HHW seem to be more stable, earlier versions (that is, earlier than version 1.22) have a tendency to crash when removing HTML Help information. Because of this, always make sure that you have the latest possible version of HHW.

  If crashes still occur, edit the API information by opening the project (.hhp) file in Notepad. Look for the sections labeled [ALIAS], [MAP], and [TEXT POPUPS].

- **View HTML Source**
  Displays the HTML of the selected file. You must select a file from the [FILES] list first.

- **Save Project, Contents, and Index Files**
  Save these three files with one click.

- **Save All Files and Compile**
  Saves all files before compiling your project.
• The Table of Contents and Index tabs display different vertical toolbars.

• The top icon on each toolbar is the respective properties icon (Contents Properties and Index Properties).

• The last two icons display the source of the selected HTML file and save either the Contents or the Index file.
  - This is slightly different from the Save icon on the Project tab, which saves the Project, Contents, and Index files.

• Each toolbar contains the Edit Selection, Delete Selection, and positioning arrow icons.

• The Contents toolbar contains icons to Insert a Heading and Insert a Page. The Index toolbar contains an icon to Insert a Keyword.
  - By default, HHW displays headings as folders.

• You can change from folders to books by modifying the Contents options.

• Once you open an HTML file, the HTML toolbar displays.

  • **Save**
    Saves the current HTML file.

  • **Display in Browser**
    Displays the current HTML file in a Help window.

  • **HTML Help ActiveX Control**
    Displays the HTML Help Wizard.

  • **Bold**
    Formats the selected text as bold.

  • **Italic**
    Formats the selected text as italic.

  • **Underline**
    Formats the selected text as underline. As a rule, Help developers use very little underlining in Help files. Hyperlinks are usually underlined and users may be confused if you use underlining for emphasis.
What Are the Advantages of HHW?

- HHW is always free.
- HHW includes an HTML editor. It includes such enhancements as text blocks, character formatting, headings, comments, and topic title dialog boxes. However, it isn't WYSIWYG.
- HHW includes the HTML Help Control Wizards for ALink Search, Close Window, HHCTRL Version, Index, Keyword Search, Related Topics, Shortcut, Splash Screen, Table of Contents, Training Card, and WinHelp Topic.
- The HHW Help file includes the HTML Help API information for C++. This enables you and your developers to attach your Help file to an application. This information must be translated for other development languages. You can get information for the most-popular languages, such as Visual Basic and Delphi, free of charge from third parties.

What Are the Disadvantages of HHW?

- HHW doesn't include a WYSIWYG editor. You need to know HTML to add content to the topic files.
  - This is by design. Microsoft knew that the tool vendors would implement HTML editors, plus there are many tools on the market available for developing HTML.
  - Popular tools include Macromedia's HomeSite, Macromedia's Dreamweaver, and Microsoft’s FrontPage, which works with Robert Chandler’s FAR (http://www.helpware.net).
- HHW doesn't include an automated linking feature (where you select the hotspot text and then select the target topic). You must code links manually.

Converting WinHelp Projects with HHW

- You can convert existing WinHelp projects with HHW.
- You assign the project (and, therefore, the compiled Help file) name during the conversion.
- HHW uses the WinHelp project name for the names of the Contents and Index files.

Advantages

- HHW converts the following items:
  - WinHelp project (.hpj) files to HHW project (.hhp) files
  - WinHelp topics (from the .rtf files) to individual HTML files
  - WinHelp Table of Contents (.cnt) files to HHW Table of Contents (.hhc) files
  - WinHelp Index to HHW Index (.hhk) files
  - WinHelp graphic (.bmp or .wmf) files to HTML graphic (.gif or .jpg) files
  - WinHelp jumps to HTML hyperlinks (but not popups)
Disadvantages

- The naming convention of the conversion process doesn't adequately identify the topic.
  - All topic file names are eight characters.
  - The first four characters indicate the document name from the WinHelp project (for example, topics from the Tasks document are prefaced with *task*).
  - The last four characters are assigned by HHW.
  - The list of file names in the [FILES] section on the Project tab follows the original document order.
- HHW doesn't convert the following WinHelp items:
  - Authorable buttons (inserted with the `{button}` command)
  - Browse buttons and browse sequences
  - Default topic setting (HHW assigns the first topic in the first document as the default topic)
  - Multiple spaces (HTML ignores spaces and tabs)
  - Non-scrolling regions
  - Popups
  - Secondary windows
  - WinHelp hypergraphic (.shg) files to HTML image maps
  - WinHelp macros
Creating an HTML Help Project with HHW

The Project file controls compilation, the look of the file, special features, context-sensitivity, and more. It contains a list of files (topic and graphic) that make up the Help system.

During this chapter, you'll learn how to create a project file, modify the project settings, customize the Help window, and add a search stop list.

Creating a Project File

To create a project file:


![Figure 1: New dialog box](image)
2. **Project** is selected by default. Click **OK** and the New Project dialog box appears.

![New Project dialog box](image1.png)

*Figure 2: New Project dialog box*

3. If you want to create a new HTML Help project, click **Next** without selecting the check box. The New Project - Destination dialog box appears.

![New Project Destination dialog box](image2.png)

*Figure 3: New Project Destination dialog box*
4. Type the path and file name information in the input box or click the Browse button to select the folder. The Open dialog box appears. Navigate to the desired folder, enter the name of the project, and click Open.

5. When you're finished, click Next. The New Project - Existing Files dialog box appears.

![New Project -- Existing Files](image)

*Figure 4: New Project Existing Files dialog box*

- Select the appropriate check boxes to add existing files to your project. Click Next on each screen that appears after selecting the desired files.
- If you don't have any files to include in your project, click Next.
- The New Project - Finish dialog box appears.

6. Click Finish. HHW creates the initial project information and displays it on the Project tab.

### Modifying the Project Settings

- New projects include the default project settings.
- If you want to include full-text search in your results, you must modify the project settings, then create the window definition.
  - If you create the window first, HHW displays a message that the project and window don't match. It's not hard to resolve the problem, since HHW displays dialog boxes where you can just click Next, but it could lead to confusion.
- Click **Change Project Options** and the Options dialog box appears. This dialog box contains four tabs.

![Project Options dialog box]

*Figure 5: Project Options dialog box*

<table>
<thead>
<tr>
<th>This option...</th>
<th>Does this...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Controls the Title, Default Topic, Default Window, and International Settings.</td>
</tr>
<tr>
<td></td>
<td>- Once you create a window, the Default Window field is updated.</td>
</tr>
<tr>
<td></td>
<td>- You can't specify a default topic until you add topic files to your project.</td>
</tr>
<tr>
<td>This option...</td>
<td>Does this...</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Files</td>
<td>Displays the path and file name of the Compiled File and Log File (if any). Enables you to specify:</td>
</tr>
<tr>
<td></td>
<td>• The Contents file or automatically create it from headings within your topic files</td>
</tr>
<tr>
<td></td>
<td>• The Index file and, if desired, include topic keywords</td>
</tr>
<tr>
<td></td>
<td>• A Full-text Search stop list, so that common words (such as “a” and “the”) aren’t included in the full-text search. I’ll discuss this in more detail later in this section.</td>
</tr>
<tr>
<td>Compiler</td>
<td>Enables you to include Notes and/or Progress information while compiling. Allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Specify compatibility (which should always be 1.1 or later)</td>
</tr>
<tr>
<td></td>
<td>• Include folder names during compilation</td>
</tr>
<tr>
<td></td>
<td>• Support enhanced decompilation</td>
</tr>
<tr>
<td></td>
<td>• Compile full-text search information</td>
</tr>
<tr>
<td></td>
<td>• Create a binary Index or Table of Contents</td>
</tr>
<tr>
<td>Merge</td>
<td>Specifies if other HTML Help files should be merged with this file when creating modular Help.</td>
</tr>
</tbody>
</table>

## Customizing the Window

To customize the window:

1. Click **Add/Modify Window Definitions**. The **Add a New Window Type** dialog box appears.

   • This dialog box only appears the first time you click the icon in a new project. Once one window definition exists, you use the **Window Types** dialog box to create additional windows.
2. Type the name for the window in the input box and click OK. The Window Types dialog box appears.

![Window Types dialog box]

*Figure 6: Window Types dialog box*

<table>
<thead>
<tr>
<th>Use this tab…</th>
<th>To do this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Add or remove existing window definitions. Enter the text for the window title bar. Text entered here overrides the title set in the Options dialog box.</td>
</tr>
<tr>
<td>Buttons</td>
<td>Set the buttons for the specified window. The default buttons are Hide/Show, Back, Options, and Print. Other choices include Forward, Stop, Refresh, Home, Locate, Jump 1, and Jump 2. For the Jump 1 and Jump 2 buttons to work, you must assign a URL or a topic file. You can add URLs on this tab, or use the File tab to enter a URL or select an existing topic. For the Home button to work, you must enter a URL or select an existing topic on the Files tab.</td>
</tr>
<tr>
<td><strong>Use this tab</strong>…</td>
<td><strong>To do this</strong>…</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Position</strong></td>
<td>Set the size and position for the specified window.</td>
</tr>
<tr>
<td></td>
<td>Click Autosizer to use drag-and-drop to position and resize the window.</td>
</tr>
<tr>
<td></td>
<td>Click Default Positions to use the default window size and position.</td>
</tr>
<tr>
<td></td>
<td>Select the check box to apply persistence to the window. This allows HHW to “remember” if users resize and reposition the window.</td>
</tr>
<tr>
<td><strong>Files</strong></td>
<td>Select the files or enter the URLs you want to use for the Table of Contents, Index, and Default topic, and for the Home, Jump 1, and Jump 2 buttons.</td>
</tr>
<tr>
<td><strong>Navigation Pane</strong></td>
<td>Select the check box to create the tri-pane window.</td>
</tr>
<tr>
<td></td>
<td>Then, enter the settings for the tri-pane window, including the width and properties of the navigation pane. Properties include:</td>
</tr>
<tr>
<td></td>
<td>• Controlling the navigational pane (whether it displays or not when the user first opens the Help file)</td>
</tr>
<tr>
<td></td>
<td>• If the Help and Contents files should auto-synchronize</td>
</tr>
<tr>
<td></td>
<td>• If the Help file should toggle the navigational pane on and off when the Help file loses focus</td>
</tr>
<tr>
<td></td>
<td>Select the default tab (the one that displays on top the first time the user opens the Help file). Specify if you want to include the Search and Favorites tabs. If you choose to include a Search tab, click the check box if you want your file to use the Advanced Search properties.</td>
</tr>
<tr>
<td></td>
<td>When you add a window definition before creating any other information, the Default Tab selection is blank. If you choose the Search and/or Favorites tabs, the Default Tab selection includes these choices. The Table of Contents and Index tabs aren't available until you create the files and add them to the Files tab.</td>
</tr>
<tr>
<td><strong>Styles and Extended Styles</strong></td>
<td>Select the styles that you want implemented in your tri-pane window.</td>
</tr>
<tr>
<td></td>
<td>Not all styles are working yet. For example, Right-to-Left Reading Order hasn't been implemented yet.</td>
</tr>
<tr>
<td></td>
<td>You have to try different combinations. However, the Help file is fine if you don't select any of these options.</td>
</tr>
</tbody>
</table>

3. Modify the window as desired. When finished, click **OK**. HHW automatically assigns the window to the project.
Adding a Search Stop List

- The full-text search stop list prevents common words, such as *the* and *or*, from displaying in the Search results when running the compiled HTML Help file. You can include numbers in the stop list.
- Including a stop list reduces the size of the full-text search index, which means that the resulting compiled file will also be smaller.
- The first step is to create the *stop list*, which is a text file with an STP extension. Use Notepad or another application that allows text files.
- One of the easiest ways to create it is to use the sample stop words listed in the HHW Help file.
  - Launch the Help file from HHW and use the Search tab to look for the topic named *To create a full-text search stop list*.
  - Copy the sample stop list and paste it into your file. If desired, add or delete stop words.
- The stop file for HHW Version 1.2 has a size limit of 512 bytes. A file created from the stop list in the HTML Help file is 507 bytes. This means that you have to be careful not to add too many words or errors will result.
- After creating the file, add it to your project by using the *Files* tab in the *Options* dialog box.

Exercise 1: Creating a Project

Before running the exercises, make sure that you have downloaded the files from the *HTML Help Center* (http://www.mvps.org/htmlhelpcenter/files.zip) and copied them to C:\Projects (or another folder of your choice).

1. Copy the sample stop file from C:\Projects\stoplist.stp to C:\Projects\Paint.
2. Create a project file called *paint* in C:\Projects\Paint.
3. Add the stop file to your project on the *Files* tab in the Options dialog box.
4. Enable full-text search for the project on the *Compiler* tab in the Options dialog box.
5. Create a new window called *main*.
   - Type *Paint Tutorial* as the Title Bar Text.
   - Select the *Save User Defined Window Position After First Use* check box.
   - Size the window to 800x600, positioned in the upper left corner of the window.
   - Turn on the navigational pane and the Search and Favorites tabs.
Chapter 4

Working with Topics

- Topics are “chunks” of information in a Help file. The following table defines the common topic types that you might use in your Help file:

<table>
<thead>
<tr>
<th>Topic Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview/Navigation</td>
<td>Describes the main concept(s) of this portion of the Help file. May help you make decisions about what other related topics you should consider.</td>
</tr>
<tr>
<td>Procedure (Task)</td>
<td>How-to instructions for completing a specific task. Usually formatted as a list of instructions.</td>
</tr>
<tr>
<td>Reference</td>
<td>Provides more concrete information than an Overview, but without the “how-to” information of a Procedure.</td>
</tr>
<tr>
<td>Definition</td>
<td>Description of a specific term or concept. Definition topics are usually accessed through popups, although they can also be lists of terms and definitions, as in a Glossary.</td>
</tr>
<tr>
<td>Examples and Demonstrations</td>
<td>Uses multimedia (graphics and/or movies) to show how to accomplish a task or the actual result after the tasks have been completed.</td>
</tr>
<tr>
<td>Context-sensitive Help</td>
<td>Opens when the user requests Help while using the application.</td>
</tr>
</tbody>
</table>

Creating New Topics

- To create a new topic in HHW:
  2. Enter the topic title and click OK. The new topic appears in a new window at the right side of HHW.

HHW doesn't enter a correct DOCTYPE. If you use HHW to create your topics, you might want to use the HTML 4.01 Transitional DOCTYPE:

```html
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN" "http://www.w3.org/TR/html4/loose.dtd">
```

3. Enter the topic content.
4. Click **Save**. The **Save As** dialog box appears. Type the file name, making sure you don't enter any spaces. (You should never use spaces in file names when working with HTML Help. You can use underscores.)

- When you create topic files in HHW, they aren't automatically assigned to the project. You must use the Topic Files dialog box to add files to your project.

## Adding Topics to a Project

1. Click **Add/Remove Topic Files** ![Add/Remove Topic Files](image) to display the Topic Files dialog box.

![Add/Remove Topic Files dialog box](image)

*Figure 7: Add/Remove Topic Files dialog box*

<table>
<thead>
<tr>
<th>Before you add the files, you need to copy them to your project folder or to a subfolder of the project.</th>
</tr>
</thead>
</table>

2. Click **Add** to display the Open dialog box. The current project folder displays.

3. Select the HTML files that you want to add to your project. HHW records the path information in all topic files.
Applying Style Sheets to Topics

- If an HTML file doesn't specify a Cascading Style Sheet (CSS), the user's browser settings control the formatting. For consistency and control, you should specify a style sheet in your HTML files.

- Add `<link rel="stylesheet" type="text/css" href="filename.css">` before the `</head>` tag.

- To add the CSS to your project:
  1. Click Add/Remove Topic Files. The Topic Files dialog box appears.
  2. Click Add. The Open dialog box displays.
  3. Type `*.css` in the File name field and press Enter.
  4. Select the CSS file and click Open.
  5. Click OK.

Setting the Default Topic

- The default topic appears as soon as users launch the Help file.

- This topic can be the first topic from the Table of Contents or it can be an “identity” topic.
  - An identity topic contains the name and copyright information for the Help file.
  - The only time users see the identity topic is when they first open the Help file.

- If you are adding a splash screen to your Help file, you add the control to the default topic. This way, users only see the splash screen when they first open the Help file.

- To set the default topic:
  1. Click Change Project Options. The General tab appears by default.
  2. Click the drop-down arrow next to Default File.
  3. Select the default topic from the list that appears.
  4. Click OK.
Exercise 2: Adding Topic Files

1. Create a new topic called **Introduction**.
2. Before the </head> tag, add the <link> tag for tutorial.css.
3. After the <body> tag, add the following text to the topic:
   
   ```html
   <h1>Introduction</h1>
   
   <p>Use Paint to create small bitmaps or modify existing bitmaps. You can also use Paint to match color palettes to prevent palette flash.</p>
   
   <ul>
     <li>Menus</li>
     <li>Color Box</li>
     <li>Status Bar</li>
     <li>Tool Box</li>
   </ul>
   ```

4. Copy the HTML files from `C:\Projects` to `C:\Projects\Paint`.
5. Add all HTML files to your project.
6. Add `tutorial.css` to your project.
7. Make the Introduction topic your default topic.
CHAPTER 5

Saving and Compiling

• Before compiling, you need to make sure that all files are saved so that the latest information is included in the results.
  • Earlier versions of HHW have been known to have problems. That is, topic files were not always saved.
• The current version of HHW seems to be having this same problem on different systems. To verify that all files are saved before compiling:
  • Close the topic file. If the file needs to be saved, a prompt appears.
• There are several ways to save HTML files:
  • Click Save on the HTML toolbar.
  • Select File > Save.
  • Select File > Save All.
Setting the Compilation Options

- Use the **Compiler** tab in the **Options** dialog box to control your compilation settings.

![Options dialog box](image)

**Figure 8: Compiler tab - Options dialog box**

<table>
<thead>
<tr>
<th>This option…</th>
<th>Does this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>While Compiling, Display Notes and/or Progress</td>
<td>Notes appear whether or not the check box is selected. Possible notes include missing topics, errors in Contents and Index files, and broken links in your project. Progress information displays the files in the project as they are processed by the compiler.</td>
</tr>
<tr>
<td>Compatibility</td>
<td>By default, compatibility is set as version 1.1 or later. The only other option is 1.0 compatibility. However, you will not be able to incorporate any version 1.1 or later functionality if compatibility is set to 1.0. This includes merging multiple .chm files and binary indexes.</td>
</tr>
<tr>
<td>This option...</td>
<td>Does this...</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Don't Include Folders in Compiled File</td>
<td>HHW allows you to use subfolders for your different files.</td>
</tr>
<tr>
<td></td>
<td>When compiling, this setting basically ignores the folder structure and puts all files in the root.</td>
</tr>
<tr>
<td></td>
<td>If any files in different folders have the same name, you must make all file names unique before using this option.</td>
</tr>
<tr>
<td>Support Enhanced Decompilation</td>
<td>Select to extract all project information, including the project file, when the Help file is decompiled.</td>
</tr>
<tr>
<td>Compile Full-Text Search Information</td>
<td>Select to include full-text search in the compiled Help file. Make sure that the Search tab is selected in the window definition.</td>
</tr>
<tr>
<td>Create a Binary Index</td>
<td>This option is selected by default.</td>
</tr>
<tr>
<td>Create a Binary TOC</td>
<td>A binary TOC reduces the size of a large Table of Contents, so that it loads more quickly. However, other features in the Table of Contents can't be used with a binary TOC.</td>
</tr>
</tbody>
</table>

**Compiling the Project**

- Compiling takes the information in the project file, including all files, and runs them through a piece of software to compress them into one file.
- The results include all topic files, graphics, and hyperlinks. The compiler also takes the information in the Contents and Index files to produce the Contents and Index tabs.
- To compile your project:
  - Click **Compile HTML File** on the main toolbar. The **Create a Compiled File** dialog box appears. The options include **Save All Files Before Compiling** and **Automatically Display Compiled Help File When Done**. Make sure the Save option is selected.
    - The Display option doesn't always work correctly or consistently.
  - Click **Save All Files and Compile** on the Project toolbar.
  - The compiler creates consecutive log files, which saves notes and progress information. When the dialog box appears, click **Save** to accept the default file name or select an existing file to overwrite.
Viewing the Results

- Once you've compiled your file, you can view it to verify the window size and position, topic information, hyperlinks, and so on.
- If you selected to automatically display the Help file, it should appear as soon as the compilation is finished.
  - However, due to a bug, the compiled Help file doesn’t always display.
- If the file doesn't appear as expected, or to view the file at any time, click View Compiled File on the main toolbar. The View Compiled File dialog box appears.
  - The current compiled file name should appear in the input box. If it doesn't, click the Browse button to navigate to the project folder and then select it.
- You can compile and view the file as often as necessary.

Exercise 3: Compiling the Project

1. Verify the compiler settings, making sure that compatibility is 1.1 or later and full-text search and binary Index are selected.
2. Save all files.
3. Compile your project.
4. View the results.
5. Close your Help file and make any modifications, as desired.
6. When you're finished, close your Help file.
Chapter 6

Creating Hyperlinks

• With HTML Help, you can choose from the following types of hyperlink destinations:
  • URL for an intranet or internet Web site page
  • URL for a topic in the same Help project
  • URL for a topic in a different Help project
  • FTP (File Transfer Protocol)
  • Bookmark (to display content from anywhere in a topic other than the beginning; called a mid-topic jump in WinHelp)
  • Newsgroups
  • E-mail address
• Because HHW doesn't include a WYSIWYG editor or automation, you must enter hyperlinks manually or through another HTML Editor.
• In HTML, a hyperlink requires two parts:
  • Type `<a href="target">` before the hotspot text.
  • Type `</a>` after the hotspot text.
• Each hyperlink destination uses a different target as the href attribute.
  • Intranet or Internet page: `target = "http://www.website.ext"`
  • URL for a topic in the same Help project: `target = "filename.htm"`
  • URL for a topic in a different Help project:
    `target = "projectfilename.chm::/topicfilename.htm"`
  • FTP: `target = "ftp://ftp.website.ext"`
  • Bookmark: `target = "filename.htm#bookmark"`
  • Newsgroups: `target = "news://news.website.ext"`
  • E-mail address: `target = "mailto:name@website.ext"`
Creating Text-Only Popups

- While HTML Help allows you to use popups, it only allows text-only popups.
  - Text-only popups don't allow any kind of text formatting, such as bold or italic, or graphics.
- In order to use text-only popups in HHW, you must use JavaScript and a customized ActiveX control.
- A basic tutorial, like this one, doesn't usually cover advanced techniques like JavaScript and ActiveX controls. However, once you become familiar with the tool, you might want to add text-only popups. Therefore, the code is provided for future use.
  - Josef Becker (http://www.helpmaster.com) has developed a JavaScript method to create popups. You can get examples and instructions at his site.

Creating the Script

- The script for a popup is:
  
  ```javascript
  <SCRIPT Language=JavaScript>
  font_info="font_family[,point size[,charset[,plain bold italic underline]]]
  popup_text_1="popup text for first popup"
  popup_text_2="popup text for second popup"
  </SCRIPT>
  ```

  - `font_info`, `popup_text_1`, and `popup_text_2` are variables for the script. You can change variable names, as long as you are consistent.
  - `font_family` is the name of the font you want to use.
  - `point size` is the size of the font.
  - `charset` is the name of the Character Set for the font. This value can be omitted.
  - `plain bold italic underline` sets the attribute for the characters.
  - For example:
    
    ```javascript
    <SCRIPT Language=JavaScript>
    popfont="Arial,10,,bold"
    popup1="This is my first popup."
    popup2="This is my second popup on the same page."
    </SCRIPT>
    ```

  - Type this code in your topic. Typically, it's entered at the bottom of the file.
Creating the ActiveX Control

- The next step is to add the code for the popup ActiveX control.
- ActiveX controls are identified by their classid.
  - You must type the classid exactly as shown or the popup won't work correctly.
  - If you will be creating more than one popup on a page, you only have to enter the ActiveX control code once.

```html
<OBJECT id=hhctrl type="application/x-oleobject"
classid="clsid:adb880a6-d8ff-11cf-9377-00aa003b7a11">
</OBJECT>
```

- `hhctrl` identifies this code when you create the hyperlink. You can change this value, if desired, as long as you are consistent.
- For example:

```html
<OBJECT id=popup type="application/x-oleobject"
classid="clsid:adb880a6-d8ff-11cf-9377-00aa003b7a11">
</OBJECT>
```

- Type this code in your topic. Typically, it's entered below the script.

Creating the Hyperlink

- Once you enter the script and ActiveX control, you can create the hyperlinks. Scripted hyperlinks are slightly different than the other examples (see "Creating Hyperlinks" on page 27).
  - This code uses the variables from Creating the Script (on page 28).

```html
<a href="JavaScript:popup.TextPopup(popup1, popfont,9,9,-1,-1)">Popup Hotspot</a>
```

- The 9, 9, variables control the left and right margins. In this case, they are set to 9 pixels each.
- The -1, -1 variables control the foreground and background colors of the popup. In this case, they use the default settings, which is black text on a dithered yellow background.
  - It is possible to change the colors. However, I've never been able to figure out what values work consistently.

Exercise 4: Creating Hyperlinks

1. In the Introduction topic, create hyperlinks to the following topics:
   - Menus
   - Tool Box
   - Color Box
   - Status Bar
The Table of Contents is one way users can navigate a Help file. It presents information in a hierarchical format, using headings and pages.

You can customize the different levels in your hierarchy by changing the default icons.

- **Headings.** By default, headings are shown by folder icons, which you can change to display books instead. They can contain sub-headings and topics and, if you want, can display a topic.
  - This functionality is different from WinHelp, which never allows a book to display a topic.
  - If you choose to use this, you should use it for all books to help prevent user confusion.
- **Topics.** By default, topics are shown by page icons. Displays a (local) topic.
- **URLs.** By default, URLs are shown by the Internet icon. Displays the address (URL, e-mail, FTP, newsgroup, multimedia, or remote topic).

![Table of Contents Not Specified](image)

**Figure 9: Table of Contents Not Specified**
• If you need to create a Contents file for your project, accept the default option by clicking **OK**. The **Save As** dialog box appears. The default file name is **Table of Contents.hhc**. However, you should never use spaces in file names in HHW, so you should change this to `projectname.hhc` or `contents.hhc` before clicking **Save**.

• The Contents tab information displays in HHW and the toolbar updates accordingly.

### Changing the Contents Settings

• To change the overall settings of your Table of Contents, click **Contents Properties**. The Table of Contents Properties dialog box appears.

![Table of Contents Properties](image)

*Figure 10: Table of Contents Properties*

<table>
<thead>
<tr>
<th>This option…</th>
<th>Does this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Frame and Default Window</td>
<td>Controls the frame and window where the topic displays. You only have to use these fields if you have customized the frameset or want your topics to display in a secondary window.</td>
</tr>
<tr>
<td>This option…</td>
<td>Does this…</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Font</td>
<td>Sets the default font for all entries. Click the Change button to select the desired font family and size.</td>
</tr>
<tr>
<td>Use Folders Instead of Books</td>
<td>Selected by default, displays headings as folders. Clear to display headings as books.</td>
</tr>
<tr>
<td>Use Custom Images from a File</td>
<td>Select to use your own icons for your Contents entries. However, a bug in HHW requires the absolute path information for the images file, rendering this useless.</td>
</tr>
</tbody>
</table>

### Changing the Headings and Pages Settings

- HHW lets you change the default icons for headings (whether originally folders or books) and pages.
- Select a heading or page on the Contents tab and click **Edit**. When the Table of Contents Entry screen displays, select the **Advanced** tab.
  - The **Window** and **Frame** fields are used with custom windows and framesets. You can use the **Comment** field, if desired.
  - **Mark as a New Entry** applies a red starburst to the default icon.
  - **Change Entry to a Page** appears when a heading is selected. **Change Entry to a Heading** appears when a page is selected. These options let you quickly change the selection.
  - **Image Index** displays auto by default. Click the up and down arrows to display the other icons that are available for headings and pages. The following table shows the available choices:

<table>
<thead>
<tr>
<th>Icon #</th>
<th>Icon</th>
<th>Icon #</th>
<th>Icon</th>
<th>Icon #</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><img src="image1.png" alt="Icon 1" /></td>
<td>15</td>
<td><img src="image15.png" alt="Icon 15" /></td>
<td>29</td>
<td><img src="image29.png" alt="Icon 29" /></td>
</tr>
<tr>
<td>2</td>
<td><img src="image2.png" alt="Icon 2" /></td>
<td>16</td>
<td><img src="image16.png" alt="Icon 16" /></td>
<td>30</td>
<td><img src="image30.png" alt="Icon 30" /></td>
</tr>
<tr>
<td>3</td>
<td><img src="image3.png" alt="Icon 3" /></td>
<td>17</td>
<td><img src="image17.png" alt="Icon 17" /></td>
<td>31</td>
<td><img src="image31.png" alt="Icon 31" /></td>
</tr>
<tr>
<td>4</td>
<td><img src="image4.png" alt="Icon 4" /></td>
<td>18</td>
<td><img src="image18.png" alt="Icon 18" /></td>
<td>32</td>
<td><img src="image32.png" alt="Icon 32" /></td>
</tr>
<tr>
<td>5</td>
<td><img src="image5.png" alt="Icon 5" /></td>
<td>19</td>
<td><img src="image19.png" alt="Icon 19" /></td>
<td>33</td>
<td><img src="image33.png" alt="Icon 33" /></td>
</tr>
<tr>
<td>6</td>
<td><img src="image6.png" alt="Icon 6" /></td>
<td>20</td>
<td><img src="image20.png" alt="Icon 20" /></td>
<td>34</td>
<td><img src="image34.png" alt="Icon 34" /></td>
</tr>
<tr>
<td>7</td>
<td><img src="image7.png" alt="Icon 7" /></td>
<td>21</td>
<td><img src="image21.png" alt="Icon 21" /></td>
<td>35</td>
<td><img src="image35.png" alt="Icon 35" /></td>
</tr>
<tr>
<td>8</td>
<td><img src="image8.png" alt="Icon 8" /></td>
<td>22</td>
<td><img src="image22.png" alt="Icon 22" /></td>
<td>36</td>
<td><img src="image36.png" alt="Icon 36" /></td>
</tr>
<tr>
<td>9</td>
<td><img src="image9.png" alt="Icon 9" /></td>
<td>23</td>
<td><img src="image23.png" alt="Icon 23" /></td>
<td>37</td>
<td><img src="image37.png" alt="Icon 37" /></td>
</tr>
<tr>
<td>10</td>
<td><img src="image10.png" alt="Icon 10" /></td>
<td></td>
<td><img src="image24.png" alt="Icon 24" /></td>
<td>38</td>
<td><img src="image38.png" alt="Icon 38" /></td>
</tr>
</tbody>
</table>
By default, HHW uses icons 5 and 6 for headings and icon 9 for pages.

You can change the icon when you first create headings and pages by clicking the Advanced tab on the Table of Contents Entry dialog box.

Adding Headings

To create a heading:

1. Click **Insert a Heading**. The Table of Contents Entry dialog box appears.
2. Type the heading title and click **OK**. The heading displays at the top of the Contents tab.

To create another heading, click **Insert a Heading** again. HHW displays a message, asking if you want to insert this heading at the top of the hierarchy. Click **Yes** or **No**.

You can always reposition books and headings later with the positional arrows.

Adding Pages

To create a page to a local topic:

1. Click **Insert a Page**. When you first insert a page, HHW displays a message, asking if you want to insert this page at the top of the hierarchy.
2. Click **Yes** or **No**. The Table of Contents Entry dialog box appears.
3. Type the page title.
4. Click **Add**. The **Path or URL** dialog box appears.
5. Select the desired topic from the list of topics and click **OK**.
6. Click **OK**.

   - By default, the page is created on the left margin. If you want the page to be an entry under a heading, use the right arrow to indent it under the desired book.

To create a page to another destination:

1. Click **Insert a Page**.
2. Type the page title.
3. Click **Add**. The **Path or URL** dialog box displays.
4. Type desired target in the **File or URL** input box at the bottom of the dialog box. (See *Creating Hyperlinks* on page 27 for targets and formatting.)

5. Click **OK** twice.

**Assigning Topics to Headings**

- To create a heading with an assigned topic:
  1. Click **Insert a Heading**.
  2. Type the heading title.
  3. Click **Add**.
  4. Select the desired topic and click **OK** twice.

- To assign a topic to an existing heading:
  1. Select the heading.
  2. Click **Edit**.
  3. Click **Add**.
  4. Select the desired topic and click **OK** twice.

**Modifying Your Project to Use the Contents File**

- If you created a custom window, you have to modify the Contents file setting after you create the Contents information. Otherwise, the Contents tab doesn't display.

  1. On the Project tab, click **Add/Modify Window Definitions**.
  2. Select the **Files** tab.
  3. Click the drop-down arrow next to **TOC** and select your contents file (filename.hhc).
  4. Select the **Navigation Pane** tab.
  5. Select **Auto Sync** and change the Default tab to **Contents** (if desired).
  6. Click **OK**.

**Exercise 5: Creating a Table of Contents**

1. Create a Table of Contents with the following headings and pages for local topics. Use the topic title as the Entry Title.

   - Heading: **Paint Tutorial** linked to **Introduction** topic
     - Pages: **Color Box**, **Status Bar**, and **Tool Box**
2. Create the following heading.

- Heading: **Help Over the Web**
  - Page:
  - Entry Title: E-mail Char
  - File or URL: mailto:CharJT@helpstuff.com
  - Icon: E-mail (number 25)
  - Page:
  - Entry Title: Microsoft's HTML Help
  - Icon: Internet (number 13)

3. Change the Table of Contents to use books instead of folders.
4. Add the Contents file to the window definition.
5. Compile and run your Help file. When you're finished, close your Help file.
Keywords create the index of the Help file.
- You can enter keywords in the Index (.hhk) file, in individual topic files, or both.
- All entries are merged during compilation into the finished index.

A Help file index is comparable to a hardcopy index. A comprehensive index helps the users navigate through your Help file.

Duplicate keywords (the same keyword assigned to two or more topics) are displayed once in the index. If the user selects that keyword, the Topics Found dialog box displays, listing all topics containing that keyword.
- For keywords to display correctly in the Index file, they must be associated with at least one topic.
- When using the Index file, you can also:
  - Add See and See Also keywords to your index (for example, “creating, see also adding”). When the user clicks this entry, the index displays the adding keyword. By using See and See Also references, you can teach your users the terminology you want them to use.
  - Customize the index. You can place index entries where desired and choose if you want to sort the Index.
  - Create a multi-level index. However, two levels is the norm.

Understanding the Differences: Sitemap and Binary Indexes

- By default, HHW creates a binary index for your compiled Help file.
  - A binary index is compiled into your project from keyword entries in the Index (.hhk) file and in the topics. You can't directly edit the binary index.
  - You must use a binary index with associative and keyword linking in your (usually merged) Help system or if you want to be able to merge indexes from different Help files.
- The Index (.hhk) file uses the sitemap format, which is an HTML file.
- The following table shows the differences between the binary and sitemap indexes.

<table>
<thead>
<tr>
<th>Binary</th>
<th>Sitemap</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only works with compiled Help files (.chm).</td>
<td>Works with either compiled Help files or Help projects displayed on a website. (This means a Sitemap Index can be compiled, but doesn't have to be.)</td>
</tr>
<tr>
<td>Binary</td>
<td>Sitemap</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Automatically sorted during compilation. Developer cannot control sorting.</td>
<td>Developer has complete control over sorting.</td>
</tr>
<tr>
<td>Compiled size is small, making this a good option for very large indexes.</td>
<td>Size is typically larger than a Binary Index. However, due to compression algorithms, this is a better choice for small indexes.</td>
</tr>
<tr>
<td>Can be merged with other indexes, which are sorted during compilation.</td>
<td>Cannot be merged with other indexes.</td>
</tr>
<tr>
<td>Must be used with associative (ALink) and keyword (KLink) linking.</td>
<td>Developer cannot use associative and keyword linking with a Sitemap Index.</td>
</tr>
</tbody>
</table>

## Creating an Index

- When you create a project with HHW, there isn't an Index (.hhk) file.
- Therefore, when you click the Index tab, HHW displays the **Index Not Specified** message. If you have a .hhk file that you can associate with the project, click the appropriate radio button and select the file.

![Index Not Specified](image)

*Figure 11: Index Not Specified*

- If you need to create a Index file for your project, accept the default option by clicking **OK**. The **Save As** dialog box displays. The default file name is **Index.hhk**. Click **Save**.
- The Index tab information displays in HHW and the toolbar updates accordingly.
- If you only use topic keywords, you don't have to use the Index tab during development at all.
Adding Index Entries to the Index File

• To create a primary (or first level) keyword associated to a local topic:

1. Click **Insert a Keyword**. The Index Entry dialog box appears.
2. Type the keyword in the **Keyword** input box.
3. Click **Add**. The **Path or URL** dialog box appears.
4. Select the topic from the list of files and click **OK**.
5. Click **OK**.

• To create a secondary (or multi-level) keyword associated to a local topic:

1. Follow steps 1 through 5 above. If the message "Do you want to insert this entry at the beginning of the index?" appears, click **No**.
2. The keyword appears as highlighted on the Index tab. Use the up and down arrows to position the keyword under its primary keyword, then use the right arrow to indent it.

• To create a keyword to another destination:

1. Click **Insert a Keyword**.
2. Type the keyword in the **Keyword** input box.
3. Click **Add**. The **Path or URL** dialog box appears.
4. Type desired target in the **File or URL** input box at the bottom of the dialog box. (See *Creating Hyperlinks* (on page 27) for targets and formatting.)
5. Click **OK** twice.

• To change the keyword title (which displays in the Topics Found list when multiple topics are associated with a keyword):

1. Click **Insert a Keyword**.
2. Type the keyword in the **Keyword** input box.
3. Click **Add**. The **Path or URL** dialog box appears.
4. Select the keyword destination.
5. Type the desired title in the **Title** input box.
6. Click **OK** twice.
   ▪ You cannot edit the title once the keyword is entered.
Adding Keywords to Topic Files

- You can add keywords to topics instead of, or in addition to, creating an index file.
- The following table describes the similarities and differences between keywords stored in topics and keywords stored in the Index file.

<table>
<thead>
<tr>
<th>Topic Keywords</th>
<th>Index File</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored within a topic (HTML file).</td>
<td>Stored within an HHK file (sitemap).</td>
</tr>
<tr>
<td>Keyword appears on Index tab only if binary index is created.</td>
<td>Can be used with either binary or sitemap indexes.</td>
</tr>
<tr>
<td>The HTML Help File must be compiled.</td>
<td>Can be used with compiled or uncompiled formats (such as WebHelp or JavaHelp).</td>
</tr>
<tr>
<td>Can be merged with other compiled HTML Help files.</td>
<td>Can be merged with other compiled HTML Help files only if saved in binary format.</td>
</tr>
<tr>
<td>Cannot be used in See and See Also references.</td>
<td>Can be used in See and See Also references.</td>
</tr>
<tr>
<td>Cannot be custom sorted (automatically alphabetical).</td>
<td>Can be custom sorted (unless saved in binary format).</td>
</tr>
<tr>
<td>Deleting keyword removes it from this topic.</td>
<td>Deleting keyword removes it from all associated topics.</td>
</tr>
<tr>
<td>Must select check box to include topic keywords in project Options.</td>
<td>Index file automatically included.</td>
</tr>
<tr>
<td>Importing topic with keywords includes all keywords in Index.</td>
<td>Importing topic doesn't include any keywords.</td>
</tr>
<tr>
<td>Can only link to local topics (within the same .chm file).</td>
<td>Can link to any hyperlink destination.</td>
</tr>
<tr>
<td>Can be used in Keyword Searches.</td>
<td>Can be used in Keyword Searches.</td>
</tr>
<tr>
<td>Cannot be used as a secondary keyword.</td>
<td>Can contain up to nine levels of keywords.</td>
</tr>
</tbody>
</table>

- To add topic keywords:
  1. Open the HTML file and position your cursor before the </body> tag.
  2. Select Edit > Compiler Information.
  3. On the Keywords tab, click Add. The Add Keyword dialog box appears.
  4. Type the keyword and click OK.
  5. Add other keywords to this topic, as desired, and click OK.

- To include topic keywords in your Help file:
  1. On the Project tab, select Change Project Options.
  2. Click the Files tab.
  3. Under Index File, select Include Keywords from HTML Files.
  4. Click OK.
Creating See and See Also Keywords

- One feature of HTML Help is the ability to create See and See Also keywords. This allows you to create cross-references (as you would in hardcopy).
  - See keywords are used for single-entry keywords.
  - See Also keywords are used for multi-level keywords.
- See and See Also keywords appear in the index, but function differently from “regular” keywords.
  - When a user clicks the See or See Also entry, the index displays the keyword assigned to that entry.
- See and See Also keywords can be entered at any index level (primary or secondary).
- See and See Also keywords always refer to primary keywords.
- You have to determine the format you will use to indicate See and See Also keywords.
  - Otherwise, the users won't know they've clicked a See or See Also keyword and can get confused.
- Some possible choices are:
  - creating topics: see also adding topics
  - creating topics
  - see also adding topics
  - creating topics (see also adding topics)
  - creating topics, see adding topics
- HHW allows you to create primary keywords that link to themselves.
  - This is a different kind of See or See Also keyword.
  - Primary keywords that are linked to themselves display the following message when selected: To locate information about this keyword, please select one of the subentries in the list.
  - This allows you to work around the hassles associated with primary level keywords, because you don't have to assign one or more topics to the keyword for it to display correctly.
- To create a See or See Also keyword:
  1. Click Insert a Keyword.
  2. Type the keyword in the Keyword input box. Make sure you include the See or See Also reference so that users understand the keyword functionality.
  3. Click Add. The Path or URL dialog box appears.
  4. Type the target keyword in the File or URL input box.
  5. Click OK.
  6. Click the Advanced tab.
  7. Select the Target is Another Keyword check box.
  8. Click OK.
To create a primary keyword that links to itself:

1. Click **Insert a Keyword**.
2. Type the keyword in the **Keyword** input box.
3. Click **Add**. The **Path or URL** dialog box appears.
4. Type the same keyword in the **File or URL** input box. This keyword must match the one entered in step 2.
5. Click **OK**.
6. Click the **Advanced** tab.
7. Select the **Target is Another Keyword** check box.
8. Click **OK**.

### Sorting the Index

- If you aren't using the binary index feature, you can custom sort the Index in your Help project.
  - The binary index feature automatically alphabetizes the Index. Custom sorting isn't possible.
- To sort the index, click **Sort Keywords Alphabetically**. All levels sort into alphabetical order.
- You can use the positional arrows to move index entries, if desired. However, once you click the Sort icon, all entries are sorted.

### Changing the Index Settings

- To change the overall settings of your Index, click **Index Properties**. The Index Properties dialog box appears.

<table>
<thead>
<tr>
<th>This option…</th>
<th>Does this…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Frame and Default Window</td>
<td>Controls the frame and window where the topic appears. You only have to use these fields if you have customized the frameset or want your topics to display in a secondary window.</td>
</tr>
<tr>
<td>Font</td>
<td>Sets the default font for all entries. Click the Change button to select the desired font family and size.</td>
</tr>
</tbody>
</table>
Modifying Your Project to Use the Index File

- If you created a custom window, you have to modify the Index file setting after you create the Index information. Otherwise, the Index tab doesn't display.

  1. On the Project tab, click **Add/Modify Window Definitions**.
  2. Select the **Files** tab.
  3. Click the drop-down arrow next to **Index** and select your index file (Index.hhk).
  4. Click **OK**.

Exercise 6: Creating an Index

1. Create the following primary level index entries and associate them with the listed topic:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>tool box</td>
<td>Tool Box</td>
</tr>
<tr>
<td>color box</td>
<td>Color Box</td>
</tr>
<tr>
<td>description</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td>Options Menu</td>
</tr>
<tr>
<td>status bar</td>
<td>Status Bar</td>
</tr>
<tr>
<td>Paint overview</td>
<td>Introduction</td>
</tr>
<tr>
<td>editing</td>
<td>Edit Colors</td>
</tr>
</tbody>
</table>

2. Create the following secondary level index entries and associate them with the listed primary keyword and topic:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Primary</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options Menu</td>
<td>description</td>
<td>Options Menu</td>
</tr>
<tr>
<td>colors</td>
<td>editing</td>
<td>Edit Colors</td>
</tr>
</tbody>
</table>

3. Create a secondary **See Also** keyword called **Paint** under description. Link it to Paint overview.

4. Sort the Index.

5. Add the Index file to the window definition.

Adding Graphics to the Project

• HHW includes the HTML Help Image Editor that you can use to create screen captures and other graphics. To launch the Image Editor, select Tools > HTML Help Image Editor or select Start > Programs > HTML Help Workshop > HTML Image Editor. Use the Help file to learn how to use the application.

• Of course, you can use any graphics application that you are familiar with.

• For this tutorial, the necessary graphics are supplied.

What Graphic Formats Can Be Included?

• GIF files are 8-bit graphic files that can display up to 256 colors. They are best used for screen prints and other small images (for example, icons). You can change the following GIF characteristics:
  • **Transparency.** You can select one color in a GIF to be “transparent,” which allows the background color or background graphic of the HTML file to show through. Remember that all areas of that color will be transparent. (If you have a graphic with a lot of white in it, you might want to change any white around the graphic to another color and then make that color transparent). The common background color for transparent graphics is fuchsia (R:255, G:0, B:255).
  • **Interlaced.** You can display a GIF as interlaced, which displays every other line of the graphic on the screen and then fills in the missing lines. This lets the user see a rough view of the graphic. Or, you can display the GIF as non-interlaced, which displays the graphic line-by-line from the top. Non-interlaced graphics are currently the most common.
  • **Animation.** You can display animated GIFs in your topic files. The animation process stores multiple GIFs in one file, which then play in sequence when the user opens the topic containing the file. Remember that less is usually more: animation can be overly distracting in Help.

• JPEG/JPG files are 16 or 24-bit graphic files that contain more than 256 colors. They are best used for photographs and other detailed graphics with many colors.

• You can also use the following graphics in your project for the specific purposes listed.
  • BMP (bitmap) files are used for splash screens, button faces, and custom Contents images. (You can also use GIFs and JPEG/JPGs for splash screens.)
  • ICO (icon) files are used for button faces.
Inserting Graphics

- To insert graphics in your topics, you use the `<img>` tag.
- The main attributes of the `<img>` tag are:
  - `src="filename.ext"`. Include the path information, if necessary.
  - `width="pixels"`. This should match the width of the graphic.
  - `height="pixels"`. This should match the height of the graphic.
  - `vspace="pixels"`. This is the number of pixels to display above and below the graphic.
  - `hspace="pixels"`. This is the number of pixels to display to the left and right of the graphic.
  - `border="pixels"`. This is the number of pixels for the width of the border.
  - `align="alignment"`. The possible choices are
    - `Default` - Uses bottom
    - `Left` - On the left margin
    - `Right` - On the right margin
    - `Top` - Top of graphic with surrounding text
    - `Middle` - Middle of graphic with surrounding text
    - `Bottom` - Bottom of graphic with surrounding text
    - `Text top` - Top of graphic with top of tallest letter on line
    - `Abs-middle` - Middle of graphic with middle of the line
    - `Baseline` - Bottom of graphic with baseline (where the capital letters sit)
    - `Abs-bottom` - Bottom of graphic with bottom of line
    - To center a graphic on a line, use the Center Paragraph option in your HTML Editor. (You can still use any of the other alignment values except Left and Right, which override the centering.)
  - `usemap="#mapname"`. The mapname must match the MAP information included in the HTML file. This information creates an image map, which is a graphic with hotspots.
- The `<img>` tag has other attributes. You can find a complete description in the HTML Tag Reference under the Help menu in HHW.

Exercise 7: Inserting Graphics

1. Copy `paint.gif` from `C:\Projects` to `C:\Projects\Paint`.
2. Insert `paint.gif` into the Introduction topic after the bullet list. Make sure you place the `<img>` tag after the `</ul>` tag. Use the following code:
   
   ```html
   <img src="paint.gif" width="xx" height="xx">
   ```
3. Compile and run your Help file. When you're finished, close your Help file.
Adding the HTML Help Control

- The main HTML Help control is stored in hhctrl.ocx, an ActiveX control designed specifically for use with HTML Help files. Just about everything you see when HTML Help is displayed comes from within this one ActiveX control.
  - **ALink Search.** Creates links to AName objects entered in topics; commonly used for dynamic related topics lists.
  - **Close Window.** Closes the current window or browser.
  - **HHCTRL Version.** Displays the current HHCTRL version in an alert box.
  - **Index.** Displays an index sitemap file.
  - **Keyword Search.** Creates links to Keywords entered in topics; commonly used for dynamic related topics lists.
  - **Related Topics.** Displays a list of coded topics.
  - **Shortcut.** Starts a program or opens a dialog box.
  - **Splash Screen.** Displays a splash screen when the compiled Help file first opens.
  - **Table of Contents.** Displays a contents sitemap file.
  - **Training Card.** Specialized Help topics that send instructions to and receive instructions from a program.
  - **WinHelp Topic.** Displays a topic from a WinHelp Help file.
- HHW includes the HTML Help wizards. These wizards display different dialog boxes, where you can enter the desired information.
- You must enter the different variables, such as keywords, AName objects, and program names.

Designing HTML Help Control Links and Results

- For all HTML Help controls except for Table of Contents and Index, you can choose how the link appears.
- For the Related Topics and Keyword Search controls, you can also choose how the output appears.
Designing the Links

- You can choose how your HTML Help controls display to the user:
  - Hotspot (with scripting) Related Topics
  - Text button Related Topics
  - Bitmap or icon (You can use any bitmap or icon). You must add the graphic file to the Baggage folder under the Project tab for the button to display correctly.

Designing the Results

- You can choose how the results of Related Topics and Keyword Searches display to the user:
  - As a popup
    
    ![ColorBox Status Bar ToolBox]

    *Figure 12: Related Links Popup*

  - As a Topics Found list
    
    ![Topics Found]

    *Figure 13: Related Links Topics Found*
Designing "No-Hit" Links

- If there's a chance that the ALink Search or Keyword Search you're coding won't have any hits, you have two choices. One controls how the link will look to the user. The other controls the results.
  - A “no-hits” link

  ![Related Topics No-Hit Link](image)

  *Figure 14: Related Topics No-Hit Link*

  - No topics available results

  ![Related Topics No Topics Available](image)

  *Figure 15: Related Topics No Topics Available*

Creating a Related Topics Button

1. Position your cursor in the topic where you want the Related Topics hotspot to appear.

2. Click HTML Help ActiveX Control . The HTML Help ActiveX Control Commands dialog box appears. Related Topics is the default choice for the HTML Help wizards. The second field is only used when scripting the hotspot (to create a text hotspot instead of a button or bitmap).
3. Click **Next**. The **Display Type** dialog box appears.

![HHCTRL Display Type](image)

*Figure 16: HHCTRL Display Type*

- Select **Hidden** if you will be scripting this control. Otherwise, accept the default for a button.
- Select **Display on a Pop-up Menu** unless you want to display the Topics Found dialog box.
- Select **Display Dialog or Menu Even if Only One Title** unless you want one hit to immediately jump to the target topic.
4. Click **Next**. The **Button Options** dialog box appears.

![HHCTRL Button Options Dialog Box]

Choose what you want displayed on the button. If you want an empty button, click Display Text On the Button and leave the text field empty.

- [ ] Display text on the button
- [ ] Display a bitmap on the button
- [ ] Display an icon on the button

Text: 

Type the button label in the Text field. If you leave this field blank, a mini-button displays (a 12x12 gray pixel button).

**Figure 17: HHCTRL Button Options**

- Accept the default selection (**Display Text on the Button**) to display the hotspot as an HTML Help button.
- If you want to display a bitmap or icon on the button instead of text, select the appropriate radio button. A Browse button displays under the Text field, so that you can navigate to the graphic.
- Type the button label in the Text field. If you leave this field blank, a mini-button displays (a 12x12 gray pixel button).
5. Click **Next**. The **Related Topics** dialog box appears.

![HHCTRL: Related Topics](image)

*Figure 18: HHCTRL Related Topics Add/Edit*

6. Add topics to the list by clicking **Add**. The **Add/Edit Related Topic** dialog box appears.

![Add/Edit Related Topic](image)

*Figure 19: Add/Edit Related Topics*

7. Enter the title for the popup menu or Topics Found list in the **Title** field. Enter the filename (or a URL) in the **File/URL** field.

8. Continue to add related topics. If necessary, edit or delete entries by clicking the appropriate button. When you've added your list of topics, click **Next**.

9. The Finish dialog box appears. Click **Finish** to create your Related Topics hotspot.
Creating a Keyword Search Button

You can't create a Keyword Search button until you add entries to the index.

1. Position your cursor in the topic where you want the Keyword Search hotspot to display.

2. Click HTML Help ActiveX Control. The HTML Help ActiveX Control Commands dialog box appears.

3. Click the drop-down arrow and select Keyword Search from the list. The second field is only used when scripting the hotspot (to create a text hotspot instead of a button or bitmap).

4. Click Next. The Display Type dialog box appears.

5. Select your display choices.

6. Click Next. The Button Options dialog box appears.

7. Select your button choices.

8. Click Next. The Keyword Search dialog box appears.

![HHCTRL: Keyword Search](image)

*Figure 20: HHCTRL: Keyword Search*

This dialog box is very similar to the Related Topics dialog box discussed previously. Click the Add button to add keywords to the list.

9. Click Next.

10. Click Finish.
Exercise 8: Creating HTML Help Controls

1. Create a new topic with the title Welcome.
2. Add the following text to the topic:
   
   `<H1>Welcome</H1>`

3. Add `crayons.gif` after the heading and center it.
4. Save the file as `Welcome.htm`.
5. Change the project settings to use Welcome as the default topic.
6. Add Welcome to the files list.
7. Compile and test your Help file. When you're finished, close your Help file.
8. Open the Introduction topic in the HTML editor.
9. Position your cursor on the line following the graphic command.
10. Insert a Related Topics HTML Help Control, specifying Menus, Color Box, Status Bar, and Tool Bar as the topics.
CHAPTER 11

Distributing Your Help File

- You must send users the .chm file. If you have referenced any external files, such as PDF or text files, make sure to ship and install them, too.
- HTML Help works best with Internet Explorer 4 or later installed. You can update your users' systems, if necessary, by running hhupd.exe, which prevents problems if the version of hhctrl.ocx on the system is earlier than the one used to compile the project.
- Running hhupd.exe is blocked on Windows 2000, Windows ME, and Windows XP. You can update hhctrl.ocx on these systems with an appropriate service pack. However, you must have permission to update the service pack and the user must have Admin rights to run it.
- For more information on what to ship with different versions of Internet Explorer and Windows, visit Rob Chandler's HTML Help - Tech Info page (http://www.helpware.net/htmlhelp/hh_info.htm), specifically the HTML Help History section.

Preparing for Distribution

- Before distributing your Help file, you need to be sure to:
  - Check for broken links and unreferenced topics
  - Verify that your external topic references (URLs, email address, and so on) exist
  - Turn on Full Text Search (in Project Settings), if desired
  - If necessary, make any corrections, then make sure everything is fixed.